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摘要 

    實驗發現檸檬酵母液的 pH 值變化量最大，木瓜酵母液甜度變化量最大，而

由比例四 1(18g): 4(72g): 1/2(10g)的 pH 值及甜度最低。以蘋果酵母製成的麵糰體

積最大，香蕉延展性最佳。不同比例的水果酵母所製成的麵糰依不同水果延展性

與體積不固定，其中大多數以比例(3) 水果：水：糖=2：2：1/2 體積最大，比例

(2) 水果:水:糖=1：2：1/2 延展性最佳。橘子酵母麵包幾乎都沒有發霉，而其餘

水果酵母大多以比例(4) 水果：水：糖=1(18g)：4(72g)：1/2(10g)發霉面積最小。

依品評結果可發現，檸檬酵母麵包為整體性最佳的麵包。 

壹、 研究動機 

    近年來食安問題四起，天然食品也隨之興起。有次在新聞上看到美國一家麵

包店的水果酵素麵包一個就賣到美金 500 元。台灣為水果王國，各季生產的水果

種類及數量繁多，經常會有生產過剩的水果。而台灣的天氣潮濕，一年四季中，

其相對溼度都非常的高，也因此食物比較容易發霉。我們就想到如果使用自己製

作的水果酵素來製作麵包，是否可以既講求天然抑制黴菌又不須花費太多的成本。

於是在老師的指導下，我們開始研究使用水果和培養時的條件對於麵包發酵的程

度最好以及抑制黴菌效果較佳。 

貳、 研究目的 

一、使用不同比例配方(糖、水、水果)對於製成後的酵母液差異比較。 

二、比較不同比例酵母液製成麵糰過程中，對麵糰發酵的影響。 

三、比較不同比例酵母液所製成麵包之發霉速率。 

四、進行品評，以了解學生對於不同天然水果酵素所製成麵包的喜好度。 

參、 研究設備與器材 

一、設備 

表 1、實驗設備 

       

糖度計 pH 計 複 式 顯 微

鏡 

解 剖 顯 微

鏡 

麵包機 烤箱 電子秤 

二、器具 

水果刀、砧板、玻璃罐、滴管、蓋玻片、載玻片、亞甲藍液、玻棒、500 克燒杯、

涼架、噴霧瓶、標籤紙、夾鏈袋、15 公分直尺、100 公分直尺。 
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三、材料 

(一)蘋果、橘子、香蕉、紫葡萄、綠葡萄、檸檬、鳳梨以及木瓜。 

(二)白砂糖。 

(三)高筋麵粉、奶油、牛奶。 

(四)速發乾酵母。 

四、電腦軟體 

Imagej：分析酵母菌數量、麵包發霉面積。 

肆、 研究過程及方法 

一、文獻回顧 

(一)天然酵母簡介 

1. 天然酵母 

    不同於單一菌種的商業酵母，以自然的方式在大自然的有機物質中取得酵母

菌，也就是天然酵母（李，2006）。菌種的培養較費時且費工，且製品的品質會

因為原料不同而有很大的差異。天然酵母是指以穀物、果實、植物的花或葉為原

料，並使其自然產生天然酵母。這些天然蔬果上包含許多微生物，如酵母菌、醋

酸菌、乳酸菌和麴菌或其他微生物。 

2. 酵母來源種類 

    作為培養酵母的原料有很多種，一般選用富含醣質的水果、穀物、蔬菜等食

材較佳，如葡萄、蘋果、小麥和馬鈴薯等，因為醣質可以轉化成酵母的營養來源。

天然酵母發酵時產生的有機酸，會使麵包具有獨特的酸味，使用不同的培養基質

其製作出來的麵包風味和質感也不同。 

表 2、天然酵母之來源與應用 

育種素材 酵母名稱 特性和應用 

穀物 酸種 1. 將水加入黑麥粉中充分揉製，以培養附著於粉上或存在於

空氣中的酵母、麴菌、乳酸菌、醋酸菌。 

2. 酸種製成的麵包具有獨特的熟成香味及酸味，主要是因菌

產生的有機酸與二氧化碳所致，有機酸還具有防止麵包老

化與風味改變的功用。 

 酒種 1. 將米、米飯、水加入麴菌中來增值酒種酵母。 

2. 麵包具有香甜的甜酒味，但發酵力較弱。 

花或葉子 啤酒花種 1. 是用授粉前的啤酒所所製成的種。 

2. 應用在麵包能充分膨脹，若配方加有少量油脂或砂糖的麵

團，更能發揮獨特的香味。 

果實 果實種 1. 有新鮮水果種和乾燥水果種兩種。 

2. 利用附著在鮮水果表皮的酵母製成的種，應用在麵包上有

淡淡的酸味及香醇風味。 
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(二)天然酵母麵包的製作

以穀物、果實和植物的花或葉為原料，並使其天然產生酵母，這些天然果蔬

上富含許多微生物，如乳酸菌、酵母菌及其他酵素活性，混合麵粉與水，低溫長

時間自動發酵，把這些附著在原料上的微生物加以培養，就可以製作具有酸味的

麵糰。 

    天然酵母所製成麵包內的微生物與一般使用乾酵母的麵包不同，所以天然酵

母麵包的特性也有所不一樣。天然酵母麵包所使用麵糰的功能為 1.增加烘焙產品

特殊風味、2.延長貯存期限、3.抑制異菌 和 4.品質地柔軟並賦予保濕作用，但因

酵母活性弱，製作出的產品體積呈現較小且質地緊密。 

    研究中，製作果實種之原料為新鮮水果，具備成為製作果實種的條件為高糖

分的水果，因為糖分為酵母的主要因素。相對地，容易釀造成酒類之水果。而當

季水果相對地比非季節性水果甜度來得高，常使用製作果實種的水果有蘋果、葡

萄等。利用自然附著在新鮮水果表皮的酵母和細菌製成的菌種，分解水果中的糖

分並利用醣類生長發酵，帶有淡淡的酸味及香醇濃厚風味。 

    發酵過程不需要氧氣，葡萄糖經由酵母菌發酵後產生酒精與二氧化碳。 

化學反應式如下： 

二、研究架構

孔隙率
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三、水果酵母麵包製作流程 
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四、酵母液與酵母種之製備 

(一)水果酵母液的配方

本研究培養液實驗以四種不同的天然水果酵母配方比例，進行實驗，以探究

四種比例的最佳的培養液，配方如表 3 所示： 

表 3、水果酵母液材料比例 

材料 比例 1 比例 2 比例 3 比例 4 

水果 1(25g) 1(29g) 2(44g) 1(18g) 

水 2(50g) 2(56g) 2(44g) 4(72g) 

糖 1(25g) 1/2(15g) 1/2(12g) 1/2(10g) 

(二)水果酵母液的製作流程

1. 使用 75%酒精消毒所使用之容器與器具。

2. 各種水果洗淨切丁。

3. 使用料理用電子秤秤量材料重量。

4. 先將糖與水均勻混和，再加入水果丁。

5. 蓋上瓶蓋密封，放置室溫培養環境。

6. 培養液於每 2 4 小時使用 pH meter 測量

pH 值，並用甜度計測量甜度，共培養七天。

7. 每天以滴管吸取水果培養液 1mL，將培養液放置 400 倍複式顯微鏡下，並

用手機拍攝照片，使用 ImageJ 計算視野中酵母菌數量。

8. 培養液於七天測得各項數據並記錄，過濾培養液，製成麵糰。

(三)水果酵母種的製作

1. 以滴管取出玻璃罐中的酵母液。

2. 酵母液與麵粉以 1:1 的比例均勻混和。

3. 放置室溫發酵 15 小時，再進行麵糰的製作。

五、天然酵母麵包之製備 

(一)麵糰配方

培養液與麵粉量為主要影響酵母發酵作用，實驗中天然酵母培養液麵糰配方

如表 4 所示： 
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表 4、酵母種及麵糰材料配方(g) 

酵母種 主麵糰 

材料 小罐 大罐 材料 小罐 大罐 

酵母液 30 1000 酵母液 40 160 

麵粉 30 1000 麵粉 100 400 

合計 60 2000 奶油 10 40 

牛奶 50 200 

合計 200 800 

(二)麵糰製作

1. 使用 75%酒精消毒所使用之容器與器具。

2. 將發酵 15 小時的酵母種及適量材料放入麵包機中攪拌 10 分鐘。

3. 將麵糰至於 2 8℃環境培養 150 分鐘。

4. 放置室溫每隔 30 分鐘測量體積、延展性。

(三)麵包製作過程

1. 將發酵 150 分鐘的麵糰整形後，放入預熱過的 180 度烤箱中烘烤 30 分鐘。 

2. 等到麵包冷卻後，再切片，將麵包放置解剖顯微鏡下，拍攝麵包切面，以

觀察麵包的孔隙。

六、天然水果酵母麵包發霉實驗 

1. 每一種水果酵母麵包切出厚 1 公分的片狀麵包，每種水果麵包三片，放入

夾鏈袋中，每日噴水一次，實驗進行一周，每日拍照一次。

2. 麵包的發霉面積，使用 ImageJ 進行分析。

七、實驗中的測量方式 

(一) 測量黴菌面積使用 ImageJ

1. 開啟 ImageJ。

2. 開啟檔案→File>open。
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3. 將影像改為 8-bit→Image>Type>8-bit。

4. 設定影像比例，先以上方工具列的第 5 項的直線工具，在拍攝的麵包畫線，

然後設定比例→Analyze>Set Scale>Know Distance。

5. 設定閾值範圍，調整 Threshold 的上下兩列的捲軸，使紅色的面積剛好覆蓋

麵包→Image>Adjus-->Threshold。

6. 計算面積，Display Results 和 Summarize 打勾→Analyze-->Analyze Particles。

7. Results 視窗就是這些區塊的資料，而 Summary 視窗就是統計這些結果，Count

代表有幾個區塊，Total Area 就是面積。

(二) 以 ImageJ 進行酵母菌手工計數

1. 開啟 ImageJ。

2. 開啟檔案→File>open。

3. 在圖片中的酵母菌上點一下，酵母菌上會出現記號。

4. 點完所有酵母菌後點選 Plugins>Analyze>Cell Counter 會顯示出一個視窗。

5. 視窗最下面的數值即是酵母菌的數量。

(三)測量發酵麵糰體積

1.在發酵的過程中，每隔

30分鐘將麵團放入 500g燒

杯中測量體積變化。 

2.紀錄麵糰的體積以測量

麵糰體積的變化。 

(四)麵糰的延展性測試方

式 

1.延展性的裝置設計如圖。 

1
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以木板為主要結構，並將麵糰固定在長尾夾上，旁邊的直尺測量延展的長度。實

驗中，每二十分鐘檢測一次麵糰的延展性，麵糰斷裂的長度便是當時的延展性。 

(五)麵包的感官品評

1.品評表：八種天然水果酵母麵包，依照風味、氣味、質地、及整體喜好度，分

別就十個層級表達喜好度。感官品評表，如附錄一。 

2.進行感官品評：由學校師生共 29 位，擔任消費者感官品評員。針對蘋果、橘

子、香蕉、紫葡萄、綠葡萄、檸檬、鳳梨以及木瓜，八種天然水果酵母麵包，其

品評項目為：風味、口感、及整體接受性。喜好性分為 10 個程度，10 代表最喜

歡，1 代表最不喜歡。

伍、 研究結果 

實驗一、分別以不同以及不一樣比例水果發酵，比較其酵母液的差異 

    首先利用蘋果、橘子、香蕉、紫葡萄、綠葡萄、檸檬、鳳梨及木瓜八種水果

做為培養酵母液的樣品，將水果、水和糖分別以比例一為 1(25g): 2(50g): 1(25g)、

比例二為 1(29g): 2(56g): 1/2(15g)、比例三為 2(44g): 2(44g): 1/2(12g)、比例四為

1(18g): 4(72g): 1/2(10g)，四種比例調配，並觀察其發酵變化的差異。完成為第一

將材料混合均勻的
麵糰取出當作測量

用麵糰

每隔20分鐘將實驗用麵糰
一端夾在長尾夾上另一端

固定在電子秤上

將棉線一端輕輕向
下拉，直到麵糰斷

裂

斷裂時長尾夾所在
的高度即是麵糰的

延展性

圖 1、自製延展性測試器具設計圖 圖 2、自製延展性測試器具完成圖 
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天，並放置在室溫培養七天，期間觀察酵母液的發酵情形，並每日測量 pH 值、

甜度以及酵母菌數量。 

(一)不同比例水果酵母比較結果：

水  果 第一天 第二天 第三天 第四天 第七天 第八天 

蘋  果  

比例一 

蘋  果 

比例二 

蘋  果 

比例三 

蘋  果 

比例四 

 

 

 

 

 

 

 

 

 

 

 

 

1.以蘋果酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著時

間遞減，其中以比例二 pH 值

＞比例四＞比例三＞比例

一，結果顯示比例一 pH 值最

小，其酵母液最酸。 

 

 

 

 

 

圖 3、不同比例蘋果酵母液 pH 值及甜度與發酵天數相關性 

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，比例一甜度＞比例二＞

比例三＞比例四，與原本酵

母液中的糖含量一致。
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水  果 第一天 第二天 第三天 第四天 第七天 第八天 

橘  子 

比例一 

橘  子 

比例二 

橘  子 

比例三 

橘  子 

比例四 

 

 

 

 

 

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞減，

比例一甜度＞比例三＞比例

二＞比例四，與原本酵母液

中的糖含量一致。 

圖 4、不同比例橘子酵母液 pH 值及甜度與發酵天數相關性 

2.以橘子酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例一 pH

值＞比例三＞比例二＞比例

四，結果顯示比例四 pH 值最

小，其酵母液最酸。
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水  果 第一天 第二天 第三天 第四天 第七天 第八天 

香  蕉 

比例一 

香  蕉 

比例二 

香  蕉 

比例三 

香  蕉 

比例四 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.以香蕉酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例一 pH

值＞比例二＞比例三＞比

例四，結果顯示比例四 pH

值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，但比例一其甜度變化量

小，而其他比例在發酵第二

天，甜度大幅下降，而比例

一甜度＞比例二＞比例三

＝比例四。 

圖 5、不同比例香蕉酵母液 pH 值及甜度與發酵天數相關性 
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水  果 第一天 第二天 第三天 第四天 第七天 第八天 

紫葡萄

比例一 

紫葡萄

比例二 

紫葡萄

比例三 

紫葡萄

比例四 

圖 6、不同比例紫葡萄酵母液 pH 值及甜度與發酵天數相關

性

4.以紫葡萄酵母液的四種比

例來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例三 pH

值＞比例一＝比例二＞比

例四，結果顯示比例四 pH

值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，每一種比例的甜度變化

量小，而比例一甜度＞比例

三＞比例二＞比例四。
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水  果 第一天 第二天 第三天 第四天 第七天 第八天 

綠葡萄

比例一 

綠葡萄

比例二 

綠葡萄

比例三 

綠葡萄

比例四 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.以綠葡萄酵母液的四種比

例來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例一 pH

值＝比例二＞比例四＞比

例四，結果顯示比例三 pH

值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，每一種比例的甜度變化

量小，而比例一甜度＞比例

二＞比例三＞比例四，與原

本酵母液中配置的糖含量

一致。 

圖 7、不同比例綠葡萄酵母液 pH 值及甜度與發酵天數相關

性
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水  果 第一天 第二天 第三天 第四天 第七天 第八天 

檸  檬 

比例一 

檸  檬 

比例二 

檸  檬 

比例三 

檸  檬 

比例四 

 

 

 

 

 

 

 

 

 

 

 

 

圖 8、不同比例檸檬酵母液 pH 值及甜度與發酵天數相關性 

6.以檸檬酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例一 pH

值＝比例三＞比例四＞比

例一，結果顯示比例一 pH

值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，以比例三的甜度波動最

大，而比例一甜度＞比例二

＞比例三＞比例四。
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7.以鳳梨酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例二 pH

值＝比例四＞比例三＞比

例一，結果顯示比例一 pH

值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，以比例一的甜度波動最

大，比例四的甜度變化不

大，而比例一甜度＞比例三

＞比例二＞比例四。 

圖 9、不同比例鳳梨酵母液 pH 值及甜度與發酵天數相關性 

圖 10、不同比例木瓜酵母液 pH 值及甜度與發酵天數相關性 

8.以木瓜酵母液的四種比例

來看： 

(1)其發酵過程的 pH 值隨著

時間遞減，其中以比例四 pH

值＝比例一＝比例二＝比

例三，結果顯示第二天的 pH

值下降的量最多，而四種比

例的 pH 值都維持一致。

(2)從甜度結果發現，其發酵

過程的甜度隨著時間遞

減，以比例二的甜度波動最

大，比例四的甜度變化不

大，而比例二甜度＞比例一

＞比例三＞比例四。
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9.四種不同比例水果酵母的酵母菌發酵最後一天數量：

水果/比例 比例一 比例二 比例三 比例四 

蘋果 

柑橘 

香蕉 

紫葡萄 

綠葡萄 

檸檬 

鳳梨 

木瓜 
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圖 11、不同比例酵母液最後一天之酵母菌數量 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1)不一樣的糖、水和水果比例：以

蘋果來看，酵母菌數量比例三＞比

例四＞比例一＞比例二；以橘子來

看，比例三＞比例一＞比例二＞比

例四；以香蕉來看，比例三＞比例

一＞比例二＞比例四；以紫葡萄來

看，比例三＞比例一＞比例二＞比

例四；以綠葡萄來看，比例三＞比

例一＞比例二＞比例四；以檸檬來

看，比例三＞比例一＞比例二＞比

例四。結果顯示，比例三中酵母菌

的數量最多，比例一酵母菌數量最

少。其中比例三為所有比例中水果

比例最高的，比例四為水的比例最

高的。顯示水果比例高的酵母液，

其酵母菌數量多；水的比例高的酵

母液，其酵母菌數量少。 

(2)不同水果種類：以比例一來看，

檸檬＞綠葡萄＞橘子＞紫葡萄＞香

蕉＞蘋果；以比例二來看，綠葡萄

＞檸檬＞紫葡萄＞橘子＞香蕉＞蘋

果；以比例三來看，橘子＞檸檬＞

綠葡萄＞紫葡萄＞香蕉＞蘋果；以

比例四來看，檸檬＞綠葡萄＞香蕉

＞紫葡萄＞蘋果＞橘子。其中以檸

檬的酵母菌數量為穩定較高的，而

蘋果的酵母菌數量為較少的。 

圖 12、不同水果酵母菌數量與酵母液中水果的百分比相關性 

圖 13、不同水果酵母菌數量與酵母液中糖的百分比相關性 
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10.統整結果分析：

 

 

(1) 實驗中將水果、水和糖分別以比例一為 1(25g): 2(50g): 1(25g)、比例二為

1(29g): 2(56g): 1/2(15g)、比例三為 2(44g): 2(44g): 1/2(12g)、比例四為 1(18g):

4(72g): 1/2(10g)，結果發現不論哪一種比例，每一種水果酵素的 pH 值、甜度

都隨著天數下降。

(2) 由圖 15 可以發現，不同水果的 pH 值變化量其排序：為紫葡萄＞綠葡萄＞檸

檬＞鳳梨＞木瓜＞蘋果＞香蕉＞橘子。顯示紫葡萄的變化量最大，橘子最小。 

(3) 由圖 16 可以發現，不同水果的甜度變化量其排序為：香蕉＞木瓜＞鳳梨＞檸

檬＞橘子＞紫葡萄＞綠葡萄＞蘋果。

(4) 比例一甜度比較高，比例四到最後一天都比較低，原因在於原本的比例上，

比例四的含糖量較低。

(5) 經觀察可發現使用比例三的酵母液其培養的酵母菌數量最多，而以橘子的數

量為最大，蘋果的數量為最少。而使用比例四水果、水和糖＝1:4:0.5 的酵母

液 pH 值、甜度皆最低，且酵母菌的數量為最少。

(二)不同水果酵母液比較結果(以比例二為例)：

以仿間比例二的配方，比較不同水果間的 pH 值以及甜度之間的差異。

圖 15、不同比例水果酵母液 pH 值變化

量

圖 16、不同比例水果酵母液甜度變化

量

圖 17、不同水果酵母液發酵期間的 pH 值變化趨勢(比例

二)

1.以 pH 值來看：第一天的

pH 值比較：紫葡萄＞檸檬

＞蘋果＞木瓜＞鳳梨＞香

蕉＞綠葡萄＞橘子。而最後

一天其 pH 值比較：蘋果＞

香蕉＞木瓜＞鳳梨＞紫葡

萄＞檸檬＝橘子。

圖 14、不同水果酵母菌數量與酵母液中水的百分比相關性 
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5.藉由常見的六種水果培養天然酵母，發現任何水果都能以糖水作為營養源，餵

養出果實本身富含的微生物及一些酵母活性。 

6.經觀察可發現香蕉從第四天開始大量產生氣泡，而橘子、紫葡萄、綠葡萄從第

二天開始產生少量的氣泡，檸檬則是第五天。顯示天然水果酵母的產氣時間不

一。 

7.由結果我們觀察到所有水果酵母液的 pH 值和甜度都隨這發酵天數遞減，因為

圖 18、不同水果酵母液發酵期間的每日 pH 值變化量(比例二) 

2.以 pH 值變化量來看：第

一天的 pH 值變化量比

較：檸檬＞鳳梨＞木瓜＞

紫葡萄＞香蕉＞綠葡萄＞

橘子。而最後一天其 pH 值

變化不大，其 pH 值變化量

以剛開始第 1-3 天較大，後

面天數趨於平緩。

圖 20、不同水果酵母液發酵期間的每日甜度變化量(比例二) 

4.以甜度變化量來看：第

一天的甜度變化量比較：

木瓜＞鳳梨＞蘋果，上述

三種水果為前三名。在發

酵過程中，木瓜、鳳梨以

及橘子的甜度變化量較

大。 

圖 19、不同水果酵母液發酵期間的甜度變化(比例二) 

3.以甜度變化趨勢來看：

第一天的甜度比較：木瓜

＞香蕉＞綠葡萄＞紫葡萄

＞蘋果＞橘子＞鳳梨＞檸

檬。而最後一天其甜度比

較：香蕉＞蘋果＞綠葡萄

＞紫葡萄＞木瓜＞檸檬＞

橘子＞鳳梨。 
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酵母菌的生長必須用到糖分才得以延續，故甜度降低。 

8.酵母菌大多呈圓形或橢圓形。結果顯示橘子、紫葡萄、檸檬的酵母液發酵程度

較好。 

實驗二、比較不同比例酵母液製成麵糰發酵的影響 

(一) 比較不同比例酵母液製成麵糰發酵的影響：將不同水果酵母液所餵養成的

酵母種加入適量材料混合所製成的麵糰，每隔半小時測量一次體積和延展性。 

 

圖 25、不同比例香蕉酵母麵糰的延展性變化  圖 26、不同比例香蕉酵母麵糰的體積變化 

)

圖 21、不同比例蘋果酵母麵糰的延展性變化        圖 22、不同比例蘋果酵母麵糰的體積變化 

)

圖 23、不同比例橘子酵母麵糰的延展性變化       圖 24、不同比例橘子酵母麵糰的體積變化 

)
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1. 蘋果麵糰：比例 1 延展性最佳，比例 2 和 4 體積最大。

圖 29、不同比例綠葡萄酵母麵糰的延展性變化  圖 30、不同比例綠葡萄酵母麵糰的體積變化 

)

圖 27、不同比例紫葡萄酵母麵糰的延展性變化  圖 28、不同比例紫葡萄酵母麵糰的體積變化 

)

圖 31、不同比例檸檬酵母麵糰的延展性變化    圖 32、不同比例檸檬酵母麵糰的體積變化 

)
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2. 橘子麵糰：比例 2 延展性最佳，比例 4 體積最大。

3. 香蕉麵糰：比例 2 延展性最佳，比例 4 體積最大。

4. 紫葡萄麵糰：比例 3 延展性最佳，比例 3 體積最大。

5. 綠葡萄麵糰：比例 3 延展性最佳，比例 3 體積最大。

6. 檸檬麵糰：比例 3 延展性最佳，比例 4 體積最大。

7. 不論哪一種比例或是哪一種水果製成的麵糰，隨著發酵時間增加，其延展性

也隨之提升；而體積也是隨著時間增加，體積逐漸變大。

(二)不同水果酵母液比較結果(以比例二為例)：

以仿間比例二的配方，將不同水果酵母液所餵養成的酵母種加入適量材料混

合所製成的麵糰，每隔半小時測量一次體積和延展性。 

 

 

 

 

 

圖 33、不同水果酵母麵糰的體積變化         圖 34、不同比例水果酵母麵糰的延展性變化 

)

0

10

20

30

40

50

60

蘋果 橘子 香蕉 紫葡萄 綠葡萄 檸檬

增
加

體
積

(立
方

公
分

)

不同水果酵母發酵150分鐘後體積增加數量

0

5

10

15

20

25

30

35

40

蘋果 橘子 香蕉 紫葡萄 綠葡萄 檸檬

伸
長

量
(公

分
)

不同水果酵母發酵150分鐘後麵團伸長量

圖 35、不同水果酵母液發酵期間增加體積 圖 36、不同水果酵母液發酵期間麵團伸長量 

1. 由結果可發現，隨著發酵時間越長，麵糰

的延展性與體積也隨之增長。

2. 蘋果麵糰的體積是所有麵糰中膨脹效果最

佳，而綠葡萄最差。

3. 香蕉麵糰的延展性最好，而蘋果最差。

4. 水果麵團在 30 分鐘內發酵體積的膨脹最

多。

圖 37、水果酵母發酵麵糰其體積變化量與時間相關性       
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實驗三、比較不同比例酵母液所製成麵包之發霉速率 

    將烘烤過的麵包切片後，使用手機拍攝不同水果酵母麵包的孔隙；每日拍照

噴水並計算發霉面積。 

表 5、發霉實驗中不同水果和比例酵母麵包之外觀變化 

水果 第一天 第二天 第三天 第四天 第五天 第六天 

蘋  果  

比例一 

蘋  果 

比例二 

蘋  果 

比例三 

蘋  果 

比例四 

橘  子 

比例一 

橘  子 

比例二 

橘  子 

比例三 

橘  子 

比例四 

香  蕉 

比例一 

香  蕉 

比例二 

香  蕉 

比例三 



24 

香  蕉 

比例四 

      

紫葡萄

比例一 

      

紫葡萄

比例二 

      

紫葡萄

比例三 

      

紫葡萄

比例四 

      

綠葡萄

比例一 

      

綠葡萄

比例二 

      

綠葡萄

比例三 

      

綠葡萄

比例四 

      

檸  檬 

比例一 

      

檸  檬 

比例二 

       

檸  檬 

比例三 
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檸  檬 

比例四 

 

 

圖 38、不同比例蘋果麵包發霉面積變化 圖 39、不同比例柑橘麵包發霉面積變化 

圖 40、不同比例香蕉麵包發霉面積變化 圖 41、不同比例紫葡萄麵包發霉面積變化 

圖 42、不同比例綠葡萄麵包發霉面積變化 圖 43、不同比例檸檬麵包發霉面積變化 

圖 44、不同比例木瓜麵包發霉面積變化 圖 45、不同比例鳳梨麵包發霉面積變化 
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(一)不同比例天然水果酵母麵包發霉狀況

1. 所有比例的天然水果酵母麵包，其上面的黴菌都會隨著天數而增加，麵包都

是從第五天開始發霉。

2. 蘋果酵母麵包第五天開始發霉，比例(1)發霉面積最小，而比例(3)最大。

3. 橘子酵母麵包除了比例(4)外，其餘得麵包幾乎沒有發霉。

4. 香蕉酵母麵包第五天開始發霉，比例(2)發霉面積最小，比例 (1)最大。

5. 紫葡萄酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(1)最大。

6. 綠葡萄酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。

7. 檸檬酵母麵包第六天開始發霉，比例(4)發霉面積最小，而比例(1)最大。

8. 鳳梨酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。

9. 木瓜酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。

(二)天然水果酵母麵包發霉狀況比較

1.實驗結果顯示，橘子和香蕉酵母麵包幾乎沒有產生霉斑，表示其貯存期限最長。 

2.蘋果、紫葡萄、綠葡萄和檸檬酵母麵包則從第四天開始產生霉斑，其中蘋果和

綠葡萄到最後一天時發霉面積最大。 

實驗四、進行品評，以了解學生對於不同天然水果酵素所製成麵包的喜好度 

(一)水果天然酵母麵包特色：天然發酵的酵母所製成的麵包，具有水果香味，因

此不一樣水果所製成的麵糰以及麵包，都會有該種水果的香氣，因為酵母的

發酵效果不如一般市售的酵母發酵的速度快，因此麵糰的發酵時間較長，而

所製成的麵糰烘烤出來的麵包，其體積也較小，外層麵包較硬。

表 6、天然水果酵素麵包切面以及麵包特色 

麵包外觀 麵包切面 顯微鏡觀察 麵包描述 

蘋

果 

麵包烘烤後顏色為褐色；麵包切

面中孔隙大小不一，且有部分沒

有孔隙；顯微鏡下孔隙很小或是

沒有。 

圖 46、不同比例水果麵包最後一天發霉面積 
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柑

橘 

麵包烘烤後顏色為淺褐色；麵包

切面中孔隙大小均勻，；顯微鏡

下均勻且有較大的孔隙。 

香

蕉 

麵包烘烤後顏色為褐色；麵包切

面中孔隙大小普通；顯微鏡下均

勻且有較大的孔隙。 

紫

葡

萄 

麵包烘烤後顏色為褐色；麵包切

面中孔隙大小均勻；顯微鏡下均

勻且有較大的孔隙。 

綠

葡

萄 

麵包烘烤後顏色為褐色；麵包切

面中孔隙大小均勻；顯微鏡下孔

隙較大且發酵狀況佳。 

檸

檬 

麵包烘烤後顏色為淺褐色；麵包

切面中孔隙大小均勻；顯微鏡下

孔隙較小且發酵狀況佳。 

鳳

梨 

麵包烘烤後顏色為淺褐色；麵包

切面中孔隙大的數量多；顯微鏡

下孔隙有大小之分。 

木

瓜 

麵包烘烤後顏色為深褐色；麵包

切面中孔隙大小均勻；顯微鏡下

孔隙大小分布均勻且發酵狀況

佳。 

1. 由圖片可以發現紫葡萄、綠葡萄、檸檬及木瓜麵包的孔洞分布及大小較均

勻，由此推測麵包鬆軟度應較高。

2. 由側面圖可發現蘋果和香蕉水果酵母麵包幾乎沒有孔隙，麵包發酵後體積

較無增長。

(二)品評結果

在水果酵母麵包製作完成後，我們請 29 位同學進行麵包的品評。依據麵包

外觀、香氣、甜度、酸度以及口感等項目，以分數 1-10 分，進行麵包評分，其

中 10 代表非常喜愛，1 代表非常不喜歡。水果酵母麵包品評的結果如下表。 
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表 7、水果酵母麵包之品評項目得分 

水果/品

評項目 
外觀 香氣 甜度 酸度 軟度 彈性 整體 

蘋果 6.7 5.6 4.6 3.4 4.7 5.3 5.5 

柑橘 7.1 5.5 5 3.4 3.9 5.2 3.9 

香蕉 6.6 4.8 4.7 2.9 5.1 5.4 5.7 

紫葡萄 7 5.2 4.1 3.2 6.1 5.3 5.7 

綠葡萄 7 5.2 4.6 3.4 5.9 5.4 6.1 

檸檬 7.3 6 4.9 3.7 6.1 6 6.3 

鳳梨 6.6 5.3 4.3 3.2 3.6 4.2 5.6 

木瓜 6.7 4.9 4.5 2.8 5.9 5.6 6 

 

 

 

 

 

 

 

 

 

 

 

 

陸、討論

一、已知酵母發酵作用(C6H12O6（葡萄糖）→2C2H5OH（酒精）+2CO2+少量能

量)會消耗糖並產生酒精和二氧化碳，所以發酵作用顯著時，甜度與 pH 值應比發

酵前更低。在實驗一中，所有的天然水果酵母在發酵過程中，其酵母液逐漸變酸，

第一天的 pH 值最大為 7，也就是紫葡萄，最小的為橘子其 pH 值為 4；最後一天

所有的天然水果酵母的 pH 值都在 3~6 之間，適合天然酵母生存。培養天然酵母

的實驗中，發現酵母液最佳的製作因子是使用橘子、紫葡萄和檸檬並以水果:水:

糖=1:4:1/2 所製成的酵母液發酵效果最佳。而比例三的酵母液其培養的酵母菌數

量最多，而以橘子的數量為最大，蘋果的數量為最少，顯示若以比例三的橘子酵

母液發酵麵包的製程可能較順利。 

二、在製作天然水果酵母麵糰中，pH 值是決定酵母在酸麵糰的適應力，由於麵

糰在發酵期間會形成有機酸，酵母在 pH 值 2.4~7.4 之 5％葡萄糖溶液中，可在無

氧狀態下生存。研究中以蘋果和橘子酵母液所製成的麵糰體積和延展性最佳，而

進一步將品評結果製作成雷達圖，如

下圖。若以外觀來看，最佳的是檸檬，

最差的是鳳梨和香蕉；以香氣來看，

最佳的是檸檬，最差的是香蕉；以甜

度來看，最佳的是柑橘，最差的是紫

葡萄；以酸度來看，最酸的是檸檬，

最不酸的是木瓜；以軟硬度來看，最

軟的是檸檬和紫葡萄，較硬的是鳳

梨；以彈性來看，最佳的是檸檬，最

差的是鳳梨；以整體來評分，最佳的

是檸檬，最差的是柑橘。顯示由各方

面來看最好吃的是檸檬酵母麵包。 

5.

圖 47、天然水果酵母麵包品評分數比較 
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在不同比例方面則無太大規律，但不同水果和比例的麵團，隨著發酵時間增長，

體積與延展性也都隨之增加。 

三、在麵包製成後的發酵實驗中，我們發現以橘子和香蕉酵母液所製成的麵包對

於防止發霉的效果最好，其中橘子酵母液更是不論何種比例，幾乎都沒有發霉跡

象。綜合前面的實驗，橘子是最適合用來製作防霉的天然水果酵母麵包的水果。 

四、在品評得過程中，同學都喜愛檸檬口味的麵包，檸檬口味的天然酵母麵包其

口感彈性佳，風味清香，並且咀嚼後有甜味，深得同學喜愛，也是麵包當中整體

感最佳的口味，未來可以做為學校或家庭自製麵包的天然水果酵母麵包。 

五、在未來，我們希望能針對發酵效果較好的橘子酵母液，以及品評後最佳的檸

檬酵母液麵包，深入了解其對於麵包防止發霉的影響，找出更健康、天然的製作

因子。另外，希望能結合實驗結果，繼續開發出防止發霉與其他特性皆較佳的製

作因子，當然各項因子實驗的精緻化，也是未來努力的方向。最後，將我們研究

出防霉效果較佳的幾項實驗組合之麵包，進行感官品評與市場調查，了解何種實

驗組合最能被消費者接受。 

柒、結論 

實驗一、使用不同比例配方(糖、水、水果)對於製成後的酵母液，差異比較 

        以水果蘋果、橘子、香蕉、紫葡萄、綠葡萄、檸檬、鳳梨和木瓜八種新鮮

水果，以糖水作為營養源，放置室溫中培養，觀察後發現大部分水果都可以培養

出果實本身富含的微生物(主要是乳酸菌和酵母菌)及一些酵母活性。 

    依實驗結果可發現，檸檬酵母液的 pH 值變化量最大，木瓜酵母液甜度變化

量最大，而由比例四 1(18g): 4(72g): 1/2(10g)的酵母液氣泡量最多，p H 值及甜度

最低。 

實驗二、比較不同比例酵母液製成麵糰過程中，對麵糰發酵的影響 

     隨著發酵時間增長，體積與延展性隨之增加。其中以蘋果酵母製成的麵糰體

積最大，香蕉延展性最佳。不同比例的水果酵母所製成的麵糰依不同水果延展性

與體積不固定，其中大多數以比例(3) 水果:水:糖=2:2:1/2 體積最大，比例(2) 水

果:水:糖=1:2:1/2 延展性最佳。 

實驗三、比較不同比例酵母液所製成麵包之發霉速率 

    天然水果酵母所製成的麵包具有延長貯存期限和抑制黴菌的功能。在不同比

例的酵母麵包中，不同比例的橘子酵母麵包幾乎都沒有發霉，而其餘水果酵母大

多以比例(4) 水果:水:糖=1(18g): 4(72g): 1/2(10g)發霉面積最小。 

    橘子酵母麵包和香蕉酵母麵包幾乎沒有發霉跡象，而蘋果酵母麵包和綠葡萄

酵母麵包發霉範圍幾乎佈滿整片麵包，表示橘子和香蕉酵母能有效延長貯存期限

和抑制異菌，而蘋果和綠葡萄酵母效果較差。 

 實驗四、進行品評，以了解學生對於不同天然水果酵素所製成麵包的喜好度 

    依品評結果可發現，檸檬麵包不論外觀、香氣、酸度、軟度、彈性都最為學

生所喜愛，而其餘水果麵包則各有學生喜歡即不喜歡的地方，由各方面來看，檸
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檬酵母麵包為最好吃的麵包。 

捌、參考資料及其他
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二、吳俊緯、郭姿儀、李抑雯。酵搖自得─水果天然酵母在麵包上的應用。中華

民國第 57 屆中小學科學展覽會 作品說明書。 

三、湯盛雄（2012）。物理科精修。台灣。 

四、詹昌明、聶家騫。剩食傳說─水果米飯麵包的製作與探討。中華民國第 59

屆中小學科學展覽會作品說明書。 

五、陳瑩珊、康浚維。擠『黴』弄『演』─研究麵包黴菌間的競爭關係。中華民

國第 51 屆中小學科學展覽會作品說明書。 

附錄一 

天然水果酵母麵包喜好度問卷表 

各位老師、同學好：這份問卷主要目的是針對我們研發的天然水果酵母麵包

喜好度的研究調查。希望大家在品嘗後，可以填寫食用完水果酵母麵包後的意

見。謝謝您的協助與合作！ 

請就 1~8 號等八種麵包之顏色、味道、口感等品質特性進行嗜好評分試驗。 

評分採十分制方式，即： 1 分─非常不喜歡，10 分─非常喜歡。  

（一）請就麵包外觀顏色，依喜好程度填寫分數。

（二）請就麵包在您試吃後針對麵包口感，包含軟硬度、彈性等，依喜好程度填

寫分數。 

（三）請就麵包之香氣、甜度..等麵包特性，依喜好程度填寫分數。

（四）請在試吃之後請就你的感覺以 1~10 進行評分。

編號 水果 外觀 香氣 甜度 酸度 口感 

軟度 

口感 

彈性 

整體 

喜好性 

1 鳳梨 

2 香蕉 

3 檸檬 

4 紫葡萄 

5 綠葡萄 

6 木瓜 

7 柑橘 

8 蘋果 

＊試吃完麵包後，請給我們一些指教跟相關建議，謝謝你的試吃跟指教。 



作品海報 

【評語】032915  

此作品的目的在找出最佳的水果酵素培養條件，比較不同水果、

不同發酵條件下所得的酵母用以製作麵包的風味，以及抗發黴的能

力，實驗的份量相常多，可看出參賽同學認真的態度。發黴實驗應

放入沒有水果酵母的一般組別作為對照組，更能比較出水果酵素存

在的抗黴作用。延展性測試的拉力大小和速度、發霉測試的每日噴

水量、和製作麵包的人皆宜固定(控制變因)，才可以避免結論產生

偏差。喜好度品評之調查對象是學生族群，宜詳細定義對象。 
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摘要
實驗發現檸檬酵母液的 pH 值變化量最大，木瓜酵母液甜度變化量最
大，而由比例四 1(18g): 4(72g): 1/2(10g)的 pH 值及甜度最低。以蘋果
酵母製成的麵糰體積最大，香蕉延展性最佳。不同比例的水果酵母
所製成的麵糰依不同水果延展性與體積不固定，其中大多數以比例(3) 

水果：水：糖=2：2：1/2 體積最大，比例 (2) 水果:水:糖=

1：2：1/2 延展性最佳。橘子酵母麵包幾乎都沒有發霉，而其餘水果
酵母大多以比例(4) 水果：水：糖=1(18g)：4(72g)：1/2(10g)發霉面積
最小。依品評結果可發現，檸檬酵母麵包為整體性最佳的麵包。

壹、研究動機
近年來食安問題四起，天然食品也隨之興起。有次在新聞上看到美
國一家麵包店的水果酵素麵包一個就賣到美金 500 元。台灣為水果
王國，各季生產的水果種類及數量繁多，經常會有生產過剩的水果。
而台灣的天氣潮濕，一年四季中，其相對溼度都非常的高，也因此
食物比較容易發霉。我們就想到如果使用自己製作的水果酵素來製
作麵包，是否可以既講求天然抑制黴菌又不須花費太多的成本。於
是在老師的指導下，我們開始研究使用水果和培養時的條件對於麵
包發酵的程度最好以及抑制黴菌效果較佳。

貳、研究目的
一、使用不同比例配方(糖、水、水果)對於製成後的酵母液差異比較。
二、比較不同比例酵母液製成麵糰過程中，對麵糰發酵的影響。
三、比較不同比例酵母液所製成麵包之發霉速率。
四、進行品評，以了解學生對於不同天然水果酵素所製成麵包的喜

好度。

叁、研究過程及方法
一、研究架構

肆、研究結果
實驗一、分別以不同以及不一樣比例水果發酵，比較其酵母液的差異

二、水果酵母麵包製作流程

圖3、不同比例蘋果酵母液pH值及甜度與發酵天數相關性

(2)從甜度結果發現，其發酵過
程的甜度隨著時間遞減，比例
一甜度＞比例二＞比例三＞比
例四，與原本酵母液中的糖含
量一致。

1.以蘋果酵母液的四種比例來
看：
(1)其發酵過程的pH值隨著時間
遞減，其中以比例二pH值＞比
例四＞比例三＞比例一，結果
顯示比例一pH值最小，其酵母
液最酸。

圖4、不同比例橘子酵母液pH值及甜度與發酵天數相關性

2.以橘子酵母液的四種比例來
看：
(1)其發酵過程的pH值隨著時間
遞減，其中以比例一pH值＞比
例三＞比例二＞比例四，結果
顯示比例四pH值最小，其酵母
液最酸。

(2)從甜度結果發現，其發酵過
程的甜度隨著時間遞減，比例
一甜度＞比例二＝比例三＞比
例四，與原本酵母液中的糖含
量一致。

3.以香蕉酵母液的四種比例
來看：
(1)其發酵過程的pH值隨著
時間遞減，其中以比例一pH

值＞比例二＞比例三＞比例
四，結果顯示比例四pH值最
小，其酵母液最酸。

(2)從甜度結果發現，其發酵
過程的甜度隨著時間遞減，
但比例一其甜度變化量小，
而其他比例在發酵第二天，
甜度大幅下降，而比例一甜
度＞比例三＝比例二＞比例
四。

圖5、不同比例香蕉酵母液pH值及甜度與發酵天數相關性

圖6、不同比例紫葡萄酵母液pH值及甜度與發酵天數相關性

4.以紫葡萄酵母液的四種比例來
看：
(1)其發酵過程的pH值隨著時間
遞減，其中以比例二pH值＞比例
三＝比例四＞比例四，結果顯示
比例四pH值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵過程
的甜度隨著時間遞減，每一種比
例的甜度變化量小，而比例一甜
度＞比例三＞比例二＞比例四。

5.以綠葡萄酵母液的四種比例來
看：
(1)其發酵過程的pH值隨著時間
遞減，其中以比例一pH值＝比
例三＞比例四＞比例三，結果顯
示比例三pH值最小，其酵母液
最酸。

(2)從甜度結果發現，其發酵過
程的甜度隨著時間遞減，每一種
比例的甜度變化量小，而比例一
甜度＞比例二＞比例三＞比例四，
與原本酵母液中配置的糖含量一
致。

圖7、不同比例綠葡萄酵母液pH值及甜度與發酵天數相關性

圖8、不同比例檸檬酵母液pH值及甜度與發酵天數相關性

6.以檸檬酵母液的四種比例來看：
(1)其發酵過程的pH值隨著時間遞
減，其中以比例一pH值＝比例三
＞比例四＞比例一，結果顯示比
例一pH值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵過程
的甜度隨著時間遞減，以比例三
的甜度波動最大，而比例一甜度
＞比例二＝比例三＞比例四。

7.以鳳梨酵母液的四種比例來看：
(1)其發酵過程的pH值隨著時間遞
減，其中以比例二pH值＝比例四
＞比例三＞比例一，結果顯示比例
一pH值最小，其酵母液最酸。

(2)從甜度結果發現，其發酵過程的
甜度隨著時間遞減，以比例一的甜
度波動最大，比例四的甜度變化不
大，而比例一甜度＞比例三＝比例
二＞比例四。

圖10、不同比例木瓜酵母液pH值及甜度與發酵天數相關性

8.以木瓜酵母液的四種比例來看：
(1)其發酵過程的pH值隨著時間遞
減，其中以比例四pH值＝比例一＝
比例二＝比例三，結果顯示第二天
的pH值下降的量最多，而四種比例
的pH值都維持一致。

(2)從甜度結果發現，其發酵過程的
甜度隨著時間遞減，以比例二的甜
度波動最大，比例四的甜度變化不
大，而比例二甜度＞比例一＞比例
三＞比例四。

圖9、不同比例鳳梨酵母液pH值及甜度與發酵天數相關性



圖15、不同比例水果酵母液pH值變化量 圖16、不同比例水果酵母液甜度變化量

圖11、不同比例酵母液最後一天之酵母菌數量

1. 實驗中將水果、水和糖分別以比例一為1(25g): 2(50g): 1(25g)、比例二為1(29g): 

2(56g): 1/2(15g)、比例三為2(44g): 2(44g): 1/2(12g)、比例四為1(18g): 4(72g): 1/2(10g)，
結果發現不論哪一種比例，每一種水果酵素的pH值、甜度都隨著天數下降。

2. 由圖16可以發現，不同水果的pH值變化量其排序：為紫葡萄＞綠葡萄＞檸檬＞鳳梨
＞木瓜＞蘋果＞香蕉＞橘子。顯示紫葡萄的變化量最大，橘子最小。

3. 由圖17可以發現，不同水果的甜度變化量其排序為：香蕉＞木瓜＞鳳梨＞檸檬＞橘
子＞紫葡萄＞綠葡萄＞蘋果。

4. 比例一甜度比較高，比例四到最後一天都比較低，原因在於原本的比例上，比例四
的含糖量較低。

5. 經觀察可發現使用比例四的水果、水和糖＝1:4:1/2的酵母液所產生的氣泡量最多。
由結果可發現，使用比例四水果、水和糖＝1:4:1/2的酵母液pH值、甜度皆最低。

(二)不同水果酵母液比較結果(以比例二為例)：

1.以pH值來看：第一天的
pH值比較：紫葡萄＞檸
檬＞蘋果＞木瓜＞鳳梨＞
香蕉＞綠葡萄＞橘子。而
最後一天其pH值比較：
蘋果＞香蕉＞木瓜＞鳳梨
＞紫葡萄＞檸檬＝橘子。

圖18、不同水果酵母液發酵期間的每日pH值變化量(比例二)

2.以pH值變化量來看：第
一天的pH值變化量比較：
檸檬＞鳳梨＞木瓜＞紫葡
萄＞香蕉＞綠葡萄＞橘子。
而最後一天其pH值變化不
大，其pH值變化量以剛開
始第1-3天較大，後面天
數趨於平緩。

圖19、不同水果酵母液發酵期間的甜度變化(比例二)

3.以甜度變化趨勢來看：
第一天的甜度比較：木瓜
＞香蕉＞綠葡萄＞紫葡萄
＞蘋果＞橘子＞鳳梨＞檸
檬。而最後一天其甜度比
較：香蕉＞蘋果＞綠葡萄
＞紫葡萄＞木瓜＞檸檬＞
橘子＞鳳梨。

圖20、不同水果酵母液發酵期間的每日甜度變化量(比例二)

4.以甜度變化量來看：第
一天的甜度變化量比較：
木瓜＞鳳梨＞蘋果，上述
三種水果為前三名。在發
酵過程中，木瓜、鳳梨以
及橘子的甜度變化量較大。

5.藉由常見的六種水果培養天然酵母，發現任何水果都能以糖水作為營養源，餵
養出果實本身富含的微生物及一些酵素活性。
6.經觀察可發現香蕉從第四天開始大量產生氣泡，而橘子、紫葡萄、綠葡萄從第
二天開始產生少量的氣泡，檸檬則是第五天。
7.由結果我們觀察到所有水果酵母液的pH值和甜度都隨這發酵天數遞減，因為酵
母菌的生長必須用到糖分才得以延續，故甜度降低。
8.蘋果酵母液的酵母菌量最多，紫葡萄最少。酵母菌大多呈圓形或橢圓形。結果
顯示橘子、紫葡萄、檸檬的酵母液發酵程度較好。

實驗二、比較不同比例酵母液製成麵糰發酵的影響

(一) 比較不同比例酵母液製成麵糰發酵的影響：將不同水果酵母液所餵養成的酵母
種加入適量材料混合所製成的麵糰，每隔半小時測量一次體積和延展性。

圖21、不同比例蘋果酵母麵糰的延展性變化 圖22、不同比例蘋果酵母麵糰的體積變化

圖23、不同比例橘子酵母麵糰的延展性變化 圖24、不同比例橘子酵母麵糰的體積變化

圖25、不同比例香蕉酵母麵糰的延展性變化 圖26、不同比例香蕉酵母麵糰的體積變化

圖27、不同比例紫葡萄酵母麵糰的延展性變化 圖28、不同比例紫葡萄酵母麵糰的體積變化

圖31、不同比例檸檬酵母麵糰的延展性變化 圖32、不同比例檸檬酵母麵糰的體積變化

1. 蘋果麵糰由比例1延展性最佳，比例2和4體積最大。
2. 橘子麵糰由比例2延展性最佳，比例2體積最大。
3. 香蕉麵糰由比例2延展性最佳，比例2和4體積最大。
4. 紫葡萄麵糰由比例3延展性最佳，比例2體積最大。
5. 綠葡萄麵糰由比例3延展性最佳，比例3體積最大。
6. 檸檬麵糰由比例3延展性最佳，比例4體積最大。
7. 不論哪一種比例或是哪一種水果製成的麵糰，隨著發酵時間增加，其延展性也隨

之提升；而體積也是隨著時間增加，體積逐漸變大。

(二)不同水果酵母液比較結果(以比例二為例)：
以仿間比例二的配方，將不同水果酵母液所餵養成的酵母種加入適量材料混合

所製成的麵糰，每隔半小時測量一次體積和延展性。

圖33、不同水果酵母麵糰的延展性變化 圖34、不同比例水果酵母麵糰的體積變化

1. 由結果可發現，隨著發酵時間越長，麵糰的延展性與體積也隨之增長。
2. 蘋果麵糰的體積是所有麵糰中膨脹效果最佳，而綠葡萄最差。
3. 香蕉麵糰的延展性最好，而蘋果最差。

實驗三、比較不同比例酵母液所製成麵包之發霉速率

(一)比較不同比例酵母液製成麵包發霉的影響：將烘烤過的麵包切片後，使用手機拍攝
不同水果酵母麵包的孔隙；每日拍照噴水並計算發霉面積。

圖17、不同水果酵母液發酵期間的每日pH值趨勢(比例二)

圖38、不同比例蘋果麵包發霉面積變化 圖39、不同比例柑橘麵包發霉面積變化

圖40、不同比例香蕉麵包發霉面積變化 圖41、不同比例紫葡萄麵包發霉面積變化

圖42、不同比例綠葡萄麵包發霉面積變化 圖43、不同比例檸檬麵包發霉面積變化

圖29、不同比例綠葡萄酵母麵糰的延展性變化 圖30、不同比例綠葡萄酵母麵糰的體積變化

圖37、水果酵母發酵麵糰其體積變化量與時間相關性
)



(二)不同比例天然水果酵母麵包發霉狀況

1. 所有比例的天然水果酵母麵包，其上面的黴菌都會隨著天數而增加
麵包都是從第五天開始發霉。

2. 蘋果酵母麵包第五天開始發霉，比例(1)發霉面積最小，而比例(3)最
大。
3. 橘子酵母麵包除了比例(4)外，其餘得麵包幾乎沒有發霉。
4. 香蕉酵母麵包第五天開始發霉，比例(2)發霉面積最小，比例(1)最大。
5. 紫葡萄酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(1)最
大。
6. 綠葡萄麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。
7. 檸檬麵包第六天開始發霉，比例(4)發霉面積最小，而比例(1)最大。
8. 鳳梨酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。
9. 木瓜酵母麵包第五天開始發霉，比例(4)發霉面積最小，比例(3)最大。

(三)天然水果酵母麵包發霉狀況比較
1.實驗結果顯示，橘子和香蕉酵母麵包幾乎沒有產生霉斑，表示其貯存
期限最長。
2.蘋果、紫葡萄、綠葡萄和檸檬酵母麵包則從第四天開始產生霉斑，其
中蘋果和綠葡萄到最後一天時發霉面積最大。

實驗四、進行品評，以了解學生對於不同天然水果酵素所製成麵包的喜
好度

(一)水果天然酵母麵包特色：天然發酵的酵母所製成的麵包，具有水果
香味，因此不一樣水果所製成的麵糰以及麵包，都會有該種水果的香
氣，因為酵母的發酵效果不如一般市售的酵母發酵的速度快，因此麵
糰的發酵時間較長，而所製成的麵糰烘烤出來的麵包，其體積也較小，
外層麵包較硬。
表 6、天然水果酵素麵包切面以及麵包特色

1. 由圖片可以發現紫葡萄、綠葡萄、檸檬及木瓜麵包的孔洞分布及大小
較均勻，由此推測麵包鬆軟度應較高。

2. 由側面圖可發現蘋果和香蕉水果酵母麵包幾乎沒有孔隙，麵包發酵後
體積較無增長。

(二)品評結果在水果酵母麵包製作完成後，我們請 29 位同學進行麵包
的品評。依據麵包外觀、香氣、甜度、酸度以及口感等項目，以分數 1-

10 分，進行麵包評分，其中 10 代表非常喜愛，1 代表非常不喜歡。水
果酵母麵包品評的結果如下表。
表 7、水果酵母麵包之品評項目得分

陸、討論

一、已知酵母發酵作用(C6H12O6（葡萄糖）→2C2H5OH（酒精）
+2CO2+少量能量) 會消耗糖並產生酒精和二氧化碳，所以發酵作用顯著
時，甜度與 pH 值應比發酵前更低。在實驗一中，所有的天然水果酵母
在發酵過程中，其酵母液逐漸變酸， 第一天的 pH 值最大為 7，也就是
紫葡萄，最小的為橘子其 pH 值為 4；最後一天所有的天然水果酵母的
pH 值都在 3~6 之間，適合天然酵母生存。培養天然酵母 的實驗中，發
現酵母液最佳的製作因子是使用橘子、紫葡萄和檸檬並以水果:水: 糖
=1:4:1/2 所製成的酵母液發酵效果最佳。而比例三的酵母液其培養的酵
母菌數量最多，而以橘子的數量為最大，蘋果的數量為最少，顯示若
以比例三的橘子酵母液發酵麵包的製程可能較順利。

二、在製作天然水果酵母麵糰中，pH 值是決定酵母在酸麵糰的適應力，
由於麵糰在發酵期間會形成有機酸，酵母在 pH 值 2.4~7.4 之 5％葡萄
糖溶液中，可在無氧狀態下生存。研究中以蘋果和橘子酵母液所製成
的麵糰體積和延展性最佳，而在不同比例方面則無太大規律，但不同
水果和比例的麵糰，隨著發酵時間增長，體積與延展性也都隨之增加。

三、在麵包製成後的發酵實驗中，我們發現以橘子和香蕉酵母液所製
成的麵包對於防止發霉的效果最好，其中橘子酵母液更是不論何種比
例，幾乎都沒有發霉跡象。綜合前面的實驗，橘子是最適合用來製作
防霉的天然水果酵母麵包的水果。

四、在品評得過程中，同學都喜愛檸檬口味的麵包，檸檬口味的天然
酵母麵包其口感彈性佳，風味清香，並且咀嚼後有甜味，深得同學喜
愛，也是麵包當中整體感最佳的口味，未來可以做為學校或家庭自製
麵包的天然水果酵母麵包。

五、在未來，我們希望能針對發酵效果較好的橘子酵母液，以及品評
後最佳的檸檬酵母液麵包，深入了解其對於麵包防止發霉的影響，找
出更健康、天然的製作因子。另外，希望能結合實驗結果，繼續開發
出防止發霉與其他特性皆較佳的製作因子，當然各項因子實驗的精緻
化，也是未來努力的方向。最後，將我們研究出防霉效果較佳的幾項
實驗組合之麵包，進行感官品評與市場調查，了解何種實驗組合最能
被消費者接受。

柒、結論

實驗一、使用不同比例配方(糖、水、水果)對於製成後的酵母液，差
異比較

以水果蘋果、橘子、香蕉、紫葡萄、綠葡萄、檸檬、鳳梨和木
瓜八種新鮮水果，以糖水作為營養源，放置室溫中培養，觀察後發
現大部分水果都可以培養出果實本身富含的微生物(主要是乳酸菌和
酵母菌)及一些酵母活性。 依實驗結果可發現，檸檬酵母液的 pH 值
變化量最大，木瓜酵母液甜度變化量最大，而由比例四 1(18g): 

4(72g): 1/2(10g)的酵母液氣泡量最多，p H 值及甜度最低。

實驗二、比較不同比例酵母液製成麵糰過程中，對麵糰發酵的影響
隨著發酵時間增長，體積與延展性隨之增加。其中以蘋果酵母

製成的麵糰體積最大，香蕉延展性最佳。不同比例的水果酵母所製
成的麵糰依不同水果延展性 與體積不固定，其中大多數以比例(3) 水
果:水:糖=2:2:1/2 體積最大，比例(2) 水果:水:糖=1:2:1/2 延展性最佳。

實驗三、比較不同比例酵母液所製成麵包之發霉速率天然水果酵母
所製成的麵包具有延長貯存期限和抑制黴菌的功能。

在不同比例的酵母麵包中，不同比例的橘子酵母麵包幾乎都沒
有發霉，而其餘水果酵母大多以比例(4) 水果:水:糖=1(18g): 4(72g): 

1/2(10g)發霉面積最小。橘子酵母麵包和香蕉酵母麵包幾乎沒有發霉
跡象，而蘋果酵母麵包和綠葡萄酵母麵包發霉範圍幾乎佈滿整片麵
包，表示橘子和香蕉酵母能有效延長貯存期限和抑制異菌，而蘋果
和綠葡萄酵母效果較差。

實驗四、進行品評，以了解學生對於不同天然水果酵素所製成麵包
的喜好度

依品評結果可發現，檸檬麵包不論外觀、香氣、酸度、軟度、
彈性都最為學生所喜愛，而其餘水果麵包則各有學生喜歡即不喜歡
的地方，由各方面來看，檸檬酵母麵包為最好吃的麵包。

進一步將品評結果製作成雷達圖，
如下圖。若以外觀來看，最佳的
是檸檬，最差的是鳳梨和香蕉；
以香氣來看，最 佳的是檸檬，最
差的是香蕉；以甜度來 看，最佳
的是柑橘，最差的是紫葡萄； 以
酸度來看，最酸的是檸檬，最不
酸的是木瓜；以軟硬度來看，最
軟的是檸檬和紫葡萄，較硬的是
鳳梨；以彈性來 看，最佳的是檸
檬，最差的是鳳梨；以 整體來評
分，最佳的是檸檬，最差的是 柑
橘。顯示由各方面來看最好吃的
是檸檬酵母麵包。

圖47、天然水果酵母麵包品評分數比較

麵包外觀 麵包切面 顯微鏡觀
察

麵包描述

蘋果
麵包烘烤後顏色為褐色；
麵包切面中孔隙大小不一，
且有部分沒有孔隙；顯微
鏡下孔隙很小或是沒有。

柑橘
麵包烘烤後顏色為淺褐色；
麵包切面中孔隙大小均
勻，；顯微鏡下均勻且有
較大的孔隙。

香蕉

麵包烘烤後顏色為褐色；
麵包切面中孔隙大小普通；
顯微鏡下均勻且有較大的
孔隙。

紫葡萄

麵包烘烤後顏色為褐色；
麵包切面中孔隙大小均勻；
顯微鏡下均勻且有較大的
孔隙。

綠葡萄

麵包烘烤後顏色為褐色；
麵包切面中孔隙大小均勻；
顯微鏡下孔隙較大且發酵
狀況佳。

檸檬

麵包烘烤後顏色為淺褐色；
麵包切面中孔隙大小均勻；
顯微鏡下孔隙較小且發酵
狀況佳。

鳳梨

麵包烘烤後顏色為淺褐色；
麵包切面中孔隙大的數量
多；顯微鏡下孔隙有大小
之分。

木瓜
麵包烘烤後顏色為深褐色；
麵包切面中孔隙大小均勻；
顯微鏡下孔隙大小分布均
勻且發酵狀況佳。

圖44、不同比例木瓜麵包發霉面積變化 圖45、不同比例鳳梨麵包發霉面積變化

圖46、不同比例水果麵包最後一天發霉面積
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